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1 About this readme file 
 
This readme contains new information, known problems, and updates to the documentation in 
support of Records Manager Enabler for Content Manager (RME) Version 8.2. 
 
Important: RME Fix Pack 7 has been built and tested with IBM® DB2® Content Manager 
V8.2 Fix Pack 7. You must install Content Manager Fix Pack 7 before installing RME Fix Pack 
7. 
 
1.1  Introduction 
 
This readme document is the first document to read when setting up and installing fix packs for 
RME Version 8.2. 

 
1.2 Who should read this readme file 
 
Anyone who will be installing, configuring, and using the Records Manager Enabler for Content 
Manager (RME) should read this readme file. 
 
The RME software enables IBM DB2 Content Manager V8.2 Fix Pack 7 (Multiplatforms and 
z/OS) and several client applications, to integrate with IBM DB2 Records Manager V3.1.1 or 
higher, to provide a US DOD 5015.2-STD compliant electronic records management solution. 
 
1.3 Ordering and support information 
 
The Records Manager Enabler for Content Manager software is available upon request to any 
IBM DB2 Content Manager Version 8.2 (Multiplatforms and z/OS®) customers.  
 
For ordering information, contact one of the IBM Content Manager sales representatives by 
clicking the How to Buy link on the following Content Manager product Web site: 
 

http://www.ibm.com/software/data/cm/cmgr/mp 
 

Ordering information on the DB2 Records Manager product can be found at the following 
Records Manager Web site: 
 

http://www.ibm.com/software/data/cm/cmgr/rm 
 
1.3.1 Obtaining support 
 
For any questions, concerns, or problems related to IBM DB2 Records Manager Enabler for 
Content Manager, visit this Web site: 
 

http://www.ibm.com/software/data/cm/cmgr/mp/support.html 
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For any questions, concerns, or problems related to IBM DB2 Records Manager, visit this Web 
site: 
  http://www.ibm.com/software/data/cm/cmgr/rm/support.html 
 
At each website, you can browse or search many technical documents, including Frequently 
Asked Questions (FAQs), Hints and Tips, defects (APARs), and other important information. 
 
1.4 License agreement 
 
Please read the license agreement information in the following license files before downloading 
and using the Records Manager Enabler for Content Manager software. The English license files 
are in the same folder you find this readme file. The license files for other languages are 
available in the RME_install_folder \License folder after executing RME_Documentation.EXE. 
 
LicenseInformation.txt  License Information 
LicenseAgreement.txt  International Program License Agreement 
LicenseInformation_xx.txt  License Information for "xx" country 
LicenseAgreement_xx.txt  International Program License Agreement for "xx" country 
 
1.5 How to send comments 
 
Your feedback helps IBM to provide quality information. Please send any comment about this 
readme file or any RME publications by sending e-mail to comments@vnet.ibm.com. 
 
2 Package content 
 
The Records Manager Enabler for Content Manager electronic package contains the following 
installation components: 
 
For Windows: 
     RME_CommonJava.EXE Installs the Common functions for Java™ components 
     RME_CommonWin32.EXE Installs the Common functions for Windows clients 
     RME_Documentation.EXE Installs the RME Documentation 
     RME_eClient.EXE  Installs the RME support for CM eClient server 
     RME_IRMClient.EXE  Installs the RME support for Records Manager server 
     RME_Notes.EXE   Installs the RME support for Lotus Notes client         
     RME_NotesInstall.EXE Script for automating installation of the RME support for 

Lotus Notes client    
For AIX: 
     RME_CommonJavaAIX  Installs the Common functions for Java components 
     RME_eClientAIX   Installs the RME support for CM eClient server 
 
For SUN: 
     RME_CommonJavaSUN Installs the Common functions for Java components 
     RME_eClientSUN  Installs the RME support for CM eClient server 
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2.1 Documentation 
 
You may want to first execute RME_Documentation.EXE to install the RME documentation on 
your system. 
 
The RME_Documenation.EXE will install RME documentation in the Documentation folder of 
the RME install folder: 
 
       RMEINSTAL.pdf Installing and Configuring the Records Manager Enabler,  

(GC18-7570-00), 96 pages 
 

       RMEUGmst.pdf  User's Guide, (SC18-7570-00), 56 pages 
 
Detailed information about system and software requirements, installation and configuration 
instructions, can be found in the Installing and Configuring the Records Manager Enabler 
publication (RMEINSTAL.pdf). 
 
The User's Guide (RMEUGMst.pdf) gives examples on how to use all of the RME client 
applications. 
 
2.2 Updates to the RME documentation 
 
This section describes the documentation changes to the two RME publications: the Installing 
and Configuring the Records Manager Enabler and the User’s Guide. 
 
2.2.1 Installation Guide changes 
 
Chapter 3. Planning for Records Manager Enabler 
 
Section "Software requirements", page 8: For the software requirements for Records Manager 
Engine and Client Server (Windows), change the following to indicate Fix Pack 6 instead of 2: 
 
 - IBM DB2 UDB Enterprise Edition Version 8.1 with Fix Pack 6 or higher 
 
Also in Section "Software requirements", page 8: Change all references to Content Manager 
components, such as IBM Content Manager Server Version 8.2 with Fix Pack 2, to Fix Pack 7. 
 
Chapter 4. Installing Records Manager Enabler 
 
Section "Installing the RME IRM Server component", page 18: Step 3: "Install 
RME_IRMClient.zip" should not be run. The new Step 3 should read as follows: 
 

3. Unzip the self-extracting RME_IRMClient.exe file and run RMEUpdate.bat whenever 
an IBM Records Manager Fix Pack is installed. 
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Note: The following steps assume that the install directory for WebSphere® Application 
Server is c:\Program Files\WebSphere\AppServer. 

  
To install the RME_IRMClient.exe file, unzip the RME_IRMClient.exe to the IRM 

 Server install folder. For example, the IRM Server may be installed at C:\Program 
 Files\WebSphere\AppServer\installedApps\[nodename]\IRMClientEAR.ear\ 

IRMClient.war where [nodename] is the host name of the machine on which the 
WebSphere Application Server is running.  
 
You must run the RMEUpdate.bat utility to update the IBM Records Manager struts-
config.xml and tiles-def.xml files to support RME enhancements on the IRM server. You 
must run this utility whenever a fix pack is installed on the IBM Records Manager 
software. 

 
This utility will update struts-config.xml and tiles-defs.xml which are located in WEB-
INF directory. Backups of the existing struts-config.xml and tiles-defs.xml files will be 
created as: struts-config.xml.orig and tiles-defs.xml.orig. 

 
 To run the RMEUpdate.bat utility, follow these steps: 

1. Stop the WebSphere application. 
 

2. Open a Command window and change directory (cd) to: 
 
C:\Program Files\WebSphere\AppServer\installedApps\[nodename]\ 
IRMClientEAR.ear\IRMClient.war 
 
where [nodename] is the host name of the machine on which the WebSphere 
Application Server is running. 
 

3. Type the following and press Enter to add the RME enhancements: 
 

RMEUpdate.bat C:\Progra~1\WebSphere WEB-INF 
 
where C:\Progra~1\WebSphere is the WebSphere installation directory in short-
name format and WEB-INF is the subdirectory (relative to the current directory)  
that contains struts-config.xml and tiles-defs.xml. 

  
 4.  Type exit and press Enter to close the Command window. 
 
Section "Deploying IRM logic extensions", page 21: Add the following new step after Step 6: 
 
 7. Click Apply. 
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Section “Installing the RME Common Client support”, page 15:  After Step 4, add this note: 
 

A script is available to help simplify the installation of the Lotus Notes RME software. 
This script combines and automates some of the manual steps associated with this 
installation. Care must be taken to ensure the data file configuration matches your 
installation settings. 
 
The script is RMENotesIns.wsf which is run from the command line as follows: 
 
cscript RMENotesIns.wsf 
 
This file and its associated data file are available in RME_NotesInstall.zip\exe 
This script performs the following steps: 
 

1. Creates RME install directory default: C:\Program Files\IBM\cm82\RME and sets 
RMEROOT variable to this. 
 

2. Creates environment variables: RMEROOT and RMELANG.  
 

3. Updates the Path with: %RMEROOT%\bin %RMEROOT%\client. 
 

4. Installs RME extensions from fixpack 6. (The script executes 
RME_COMMONWin32.exe which unpacks the RME extensions into the RME 
install path.) 
 

5. Registers SOAP dll (The script executes regsvr32 SoapHeaderHandler.dll 
from directory: %RMEROOT%\bin)  
 

6. Registers MIME types and assigns helper application. The script assigns helper 
application as either DXLImport.bat for Notes or LaunchDXLViewer.bat for 
Internet Explorer. The script also sets up which application to use when viewing 
Notes emails. The choices are Notes Client or Internet Explorer browser. 

 
Associated with the script is the file RMENotesIns.txt  which contains the installation 
criteria. The file consists of a header line for a particular install item,  
followed by the information associated with that item.  Do not make any changes  
to the header lines. 
 
The following is a description of the RMENotesIns.txt file: 
 
Running Mode (prompt/quiet): Prompt 
The running mode for the script, whether to prompt before proceeding or not. 
You may want to run in prompt mode for the first few installations in order to verify  
that the data is correct for your installation. 
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RME Install Path: c:\Program Files\IBM\cm82\RME 
This is the path where you want the RME extensions installed, it is currently set to  
the default for this path. 
 
RME Language: en 
This is the language to be used for RME messages. 
Valid values are: de, en, es, fr, it, ja, ko, pt, zh, zh_TW 
 
Install Package Path: .\RME_COMMONWin32.default.exe 
This is a path to the RME Win32 installation package.  It will be installed by the script. 
 
Windows Client Helper Application:  
c:\Program Files\IBM\cm82\RME\notes\DXLImport.bat 
This is the path to the helper application to use for viewing Notes emails using the  
CM Client for Windows.  This can have the following values: 
 

To use the Lotus Notes client to view the email:  
c:\Program Files\IBM\cm82\RME\notes\DXLImport.bat 
 
To have the email displayed in Internet Explorer:  
c:\Program Files\IBM\cm82\RME\notes\LaunchDXLViewer.bat 
 
The paths provided assume the default installation path; they can be modified to suit  
your particular installation. 

 
eClient Viewer Application: 
c:\Program Files\IBM\cm82\RME\notes\LaunchDXLViewer.bat 
Similar to above for assigning the application to use for viewing Notes emails for  
use with the CM eClient. 
 
Lotus Notes Install Path: c:\notes 
This is the path where the Lotus Notes application is installed. If Lotus Notes is  
not installed on the target system then enter: none.  This also means that  
the Lotus Notes viewer should not be specified in the options above. 

 
Section "Installation of RME CM eClient server component", page 23: Modifications to the 
listed eClient JSPs are no longer needed. Strike-through the first bulleted item in Step 3. Install 
RME_eClient.zip. This item no longer needs to be completed because you must have already 
installed the required CM eClient V8.2 Fix pack 7, which includes these changes. 
 
Section "Installation of RME CM eClient server component", page 24: The step "Adding RME 
servlets to the eClient server" is no longer necessary. Strike-through the complete step and 
continue to "Customizing the eClient server to support new MIME types" on page 25. This step 
no longer needs to be completed because you must have already installed the required CM 
eClient V8.2 Fix pack 7, which already includes these changes. 
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Section “Installing the RME CM Client component”, page 25: This section no longer needs to be 
completed because you must have already installed the required CM Client V8.2 Fix pack 7, 
which already includes these changes. 
 
Section “Implementing RME Support at the Lotus Notes client application level”, on page 29: 
Add the following new step e: 
 

e. In the current release, when the e-mail body is exported from the Notes client, it is 
encoded in base 64 format. This may not display properly if it is desired to display the 
e-mail outside of the Lotus Notes application (for example with the eClient browser 
application). The default as of this fixpack is no encoding. If encoding is desired, then 
add the following line to the notes.ini file: 

 
RMEDXLBase64Encode=1 
 
If encoding is specified, this will have the affect that any attempt to display the e-mail 
body using one of the CM clients (eClient or Windows Client) will not render 
correctly and be unreadable. 

 
Section “Using the RME Lotus Notes templates”, on page 30: the fourth bullet after Step 8 
should read: 
 

• Double-click RME Notes Email Fields subform on the right pane window to open 
the subform. 

 
Section “Configure RME components to communicate with CM server”, page 34: Add the 
following note under Utility usage: 
 

Note: This should be invoked within a Java-enabled environment such as the EIP 
Development Window. Also, you should change directory to where the cmbicmenv.ini 
file resides (for example, c:\Program Files\IBM\CMgmt) so the updates overwrite the 
existing files. 

 
Chapter 5. Configuring Records Manager Enabler system 
 
Section "Using RMECMSetup tool to set up the CM server", page 43: For Step 3, if you have 
more than one CM server, you must use the same RMEAdmin password for each CM server. 
 
Section “Managing RME configuration information”, page 46: Add the following note under the 
graphic of the RME Configuration Tool: 
 

Note: Only the DB2 Records Manager Server button is enabled the first time you login 
to the RMEconfig tool. The other buttons are enabled after you input and save the 
information specified when using the DB2 Records Manager Server button. 
 
 

 Version 1.0  
8 



IBM Records Manager Enabler for Content Manager Version 8.2 Fix Pack 7 readme 

 
Appendix B. Other configurations for the Lotus Notes client 
 
Section “Setting User ID password options”, page 76: New step 1 should read: 
 

1. For Notes 5, select File → Tools → User ID.  
For Notes 6, select File → Security → User Security. 

 
2.2.2 User’s Guide changes 
 
Chapter 2. Using the Content Manager eClient 
 
Add the following new sections after the end of “Viewing record information” on page 15:  
 

Defining Helper Applications 
To display Notes documents from the CM eClient, you must specify a helper application 
to handle the DXL file type. There are two methods to do so: 
 
1. Export the Notes document from CM and import it into a Notes client database. Notes 

is then launched to view the document. 
 

2. Export the Notes document from CM and display it using Internet Explorer. 
 
Before proceeding, make sure the MIME type for the DXL file has been set. This is done 
using the regupdate.bat file located in directory %RMEROOT%/Notes. Run this batch 
file to update the Windows registry with the file type information for the Notes file type 
(DXL). 
 
Using Notes Client for viewing exported email 
The DXLImport.bat batch file is used as the helper application in eClient to launch the 
Notes client. This will import the selected email into a new Notes database 
(RMERecordViewer.nsf). The batch file is located in \%RMEROOT%\notes. 
 
 
DXLImport.bat contains two lines: 
 
RMEDXLImport.exe %1 local 
Notes.exe 

  
This will also launch the Notes client application after the import process completes. 
 
Follow these steps to define the Notes client as the DXL File Type helper application for 
CM eClient: 
 
1. In Windows Explorer, click Tools → Folder Options. 
 
2. Click File Types. 
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3. Click New. 
 

4. Type DXL in the File Extension field on the Create New Extension window and 
click OK. 

 
5. Click Change. 

 
6. Choose Select the program from a list. 

 
7. Click Browse to find the DXLImport.bat file. It is located in %RMEROOT%\notes. 

This will export the Notes document from CM and import it into the 
RMERecordViewer.nsf Notes database on the local disk. It will also launch the Lotus 
Notes application. 

 
8. Click OK to save the definition.  

 
9. Click Close to close the Folder Options window. 

 
Using Internet Explorer for viewing exported email 
The LaunchDXLViewer.bat batch file is used as the DXL File Type helper application in 
eClient to launch the DXL in Internet Explorer. The batch file is located in 
\%RMEROOT%\notes. 
 
The LaunchDXLViewer.bat file contains the following two lines.  
 
copy %1 “%RMEROOT%\notes\view.dxl” 
start iexplore file://%RMEROOT%\notes\DXLViewer.html?view.dxl,MemoDXLtoHTML.xsl 
 

emoDXLtoHTML.xsl is a sample style sheet. It can be replaced by a custom style sheet.M  

ollow these steps to define Internet Explorer as a helper application for eClient: 
 

. In Windows Explorer, click Tools → Folder Options. 

2. Click File Types. 
 

3. Click New. 
 

4.  the File Extension field on the Create New Extension window and 
click OK. 

 
5. Click Change. 

 
6. Choose Select the program from a list. 

 

 

F

1
 

Type DXL in
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7. Click Browse button to find the LaunchDXLViewer.bat file. It is located in 

%RMEROOT%\notes. This will export the Notes document from CM and start 
Internet Explorer and display the email. 

 
8. Click OK to save the definition.  

 
9. Click Close to close the Folder Options window. 

 
Chapter 3. Using the Content Manager Client for Windows 
 
Replace the section “Helper Application for Note e-mail messages and documents” on page 28 
with the following three new sections.  
 

Helper Application for the Notes e-mail messages and documents 
In order to display Notes documents from the CM Client from Windows, you must specify 
a helper application to handle the DXL file type. There are two ways to do this: 
 
1. Export the Notes document from CM and import it into a Notes client database. Notes 

is then launched to view the document. 
 

2. Export the Notes document from CM and display it using Internet Explorer. 
 

Before proceeding, make sure the MIME type for the DXL file has been set. This is done 
using the regupdate.bat file located in directory %RMEROOT%/Notes. Run this batch 
file to update the Windows registry with the file type information for the Notes file type 
(DXL). 

 
Using Notes Client for viewing exported email 
The DXLImport.bat batch file is used as the helper application in CM Client for 
Windows to launch the Notes client. This will import the selected email into a new Notes 
database (RMERecordViewer.nsf). The batch file is located in \%RMEROOT%\notes. 
 
DXLImport.bat contains two lines: 
 
RMEDXLImport.exe %1 local 
Notes.exe 

  
This will also launch the Notes client application after the import process completes. 
 
Follow these steps to define the Notes client as the DXL File Type helper application for 
CM Client for Windows: 
 
1. In CM Client for Windows, click Options → Preferences. 
 
2. Click Helper Applications. If the CM system administrator created a new MIME 

type called DXL during RME installation, it will be listed in the File Type drop-
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down list. If not, ask a CM system administrator to create a new DXL file type for 
you. 

 
3. Select DXL entry from the list of File Types. 

 
4. Specify DXL as the File Extension. 

 
5. Select the Launch Application option at the bottom. 

 
6. Click Browse to find the DXLImport.bat file. It is located in %RMEROOT%\notes. 

This will export the Notes document from CM and import it into the 
RMERecordViewer.nsf Notes database located on the local disk. It will also launch 
the Lotus Notes application. 

 
7. Click OK to save the definition.  

 
Using Internet Explorer for viewing exported email 
The LaunchDXLViewer.bat batch file is used as the helper application in CM Client for 
Windows to launch the DXL in Internet Explorer. The batch file is located in 
\%RMEROOT%\notes. 
 
The LaunchDXLViewer.bat file contains the following two lines.  
 
copy %1 “%RMEROOT%\notes\view.dxl” 
start iexplore file://%RMEROOT%\notes\DXLViewer.html?view.dxl,MemoDXLtoHTML.xsl 
 

emoDXLtoHTML.xsl is a sample style sheet. It can be replaced by a custom style sheet.M  

rnet Explorer as the DXL File Type helper application for 
M Client for Windows: 

 
. In Client for Windows, click Options → Preferences. 

2.  

 list. If not, ask a CM system administrator to create a new DXL file type dro 
you. 

 
3. Select Lotus DXL entry from the list of File Types. 

 
4. Specify DXL in the Extension field. 

 
5. Select the Launch Application option at the bottom. 

 
6. 

the Notes document from CM and start 
Internet Explorer and display the email. 

 

Follow these steps to define Inte
C

1
 

Click Helper Applications. If the CM system administrator created a new MIME
type called DXL during RME installation, it will be listed in the File Type drop-
down

Click Browse button to find the LaunchDXLViewer.bat file. It is located in 
%RMEROOT%\notes. This will export 
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7. Click OK to save the helper application definition.  

hapter 4. Using the Lotus Notes client 

e section “Browsing Lotus Notes records” on page 39 with the following three new 
ctions.  

 
rowsing Lotus Notes records 

browse Lotus Notes records either through the CM Client for Windows or the CM 
Client. 

 
ser’s Guide Chapter 3:“Using the Content Manager Client for Windows” in this guide. 

 update to the User's Guide 
Chapter 2: “Using the Content Manager eClient” in this guide. 

.3 NLS Documentation 

he RME documentation is available in the following languages:  
 

 

 

• Traditional Chinese (zh_TW). 

 the PDF and HTML versions of the NLS 
ocumentation are available in the following folder: 

      RME_install_folder\Documentation\HTML folder 

h country will have their own folder with the two characters 
ountry code as the folder name: 

 
ntry code  

 

 
 
C
 
Replace th
se

B
 
You can 
e
 
For instructions on the configuration of the CM Client for Windows, see the update to the
U
 
For instructions on the configuration of the CM eClient, see the

 
2
 
T

• English (en)
• French (fr) 
• German (de) 
• Japanese (ja) 
• Korean (ko) 
• Brazilian Portuguese (pt)
• Simplified Chinese (zh) 

 
When you install the RME_Documentation.EXE file,
d
 
        RME_install_folder\Documentation\PDF folder 
  
 
In the PDF and HTML folder, eac
c

Cou Country
en English 
de German
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zh_TW Traditional Chinese 

Notes: 

• k (rmeinst) is 
ese. 

• The RME documentation is NOT translated to Italian or Spanish. 

.3.1 PDF version 

ou can read the PDF documentation by using the Adobe Acrobat reader. 

.3.2 HTML version 

ou can open the HTML files by using one of the web browsers: 
 
rmeugmst.htm ontains the cover page for the RME User's guide 

rmeugmst02.htm ontains the Table of Contents and links to all the chapters 

rmeinstal.htm  Installing and Configuring the Records 
anager Enabler publication 

rmeinstal02.htm Contains the Table of Contents and links to all the chapters 
 

fr French 
ja Japanese
ko Korean 
pt Brazilian Portuguese
zh Simplified Chinese 

         

• The RME User's Guide (rmeug) is available in the above 8 languages. 
The RME Installing and Configuring the Records Manager Enabler boo
available only in English, Japanese, Korean, and Brazilian Portugu

 
2
 
Y
 
2
 
Y

C
 
C
 
Contains the cover page for the
M
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3 Updates to installation procedures 
 
To install the RME Fix pack 7, follow the installation steps in Chapters 4 and 5 of Installing and 
Configuring the Records Manager Enabler while noting the documentation changes described in 
Section 2.2 “Updates to the Documentation” on page 4 of this document. 
 
The RME installation procedure has been simplified by replacing the RME component zip files 
(RME_xxxxxx.zip) with self-extracted files (RME_xxxxxx.EXE). This fix pack is a complete 
product refresh. That is, you must replace the existing files when the new files are extracted from 
the zip files. 
 
The following is the mapping of the RME_xxxxxx.zip files to the RME_xxxxxx.EXE files: 
 
Zip file names Self-extracted file names 
RME_CommonJava.zip RME_CommonJava.EXE 
RME_CommonWin32.zip RME_CommonWin32.EXE 
RME_Documentation.zip RME_Documentation.EXE 
RME_eClient.zip RME_eClient.EXE 
RME_IRMClient.zip RME_IRMClient.EXE 
RME_Notes.zip RME_Notes.EXE 
RME_NotesInstall.zip RME_NotesInstall.EXE 

 
In addition, we have included the following new installation components for the installation of 
RME support for eClient server on AIX and SUN Solaris system platforms: 
 
          RME_CommonJavaAIX 
          RME_eClientAIX 
 
          RME_CommonJavaSUN 
          RME_eClientSUN 
 
See Section 3.2 in this readme for installation instructions for these new files. 
 
3.1 Understanding the installation requirements 
 
This section is an updated version of the "Understanding the installation requirement" section on 
page 12 of the Installing and Configuring Records Manager Enabler document. The only thing 
we have changed is to replace RME_xxxxxx.zip with RME_xxxxxx.EXE. Other installation 
requirements are NOT changed. 
 
This section lists the software requirements and RME installation files required to support RME 
functions for each of the RME components. 
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RME component Installation requirements 
Records Manager server Content Manager V8 Connector V8.2 with Fix Pack 7 

RME_CommonJava.EXE 
RME_CommonWin32.EXE 
RME_IRMClient.EXE 

  
CM eClient server for Windows RME_CommonJava.EXE  

RME_eClient.EXE 
  
CM eClient server for AIX RME_CommonJavaAIX  

RME_eClientAIX 
  
CM eClient server for SUN RME_CommonJavaSUN  

RME_eClientSUN 
  
CM Client for Windows V8.2 Microsoft Simple Object Access Protocol (SOAP) Toolkit V3.0 

Microsoft Visual C++ V6.0 or Microsoft .NET 
Microsoft MSXML Parser V4.0 
RME_CommonWin32.EXE 

  
Lotus Notes client IBM DB2 Run-Time Client Version 8.1 with Fix Pack 3 

Content Manager V8 Connector V8.2 with Fix Pack 7 
Microsoft Simple Object Access Protocol (SOAP) Toolkit V3.0 
Microsoft Visual C++ V6.0 or Microsoft .NET 
Microsoft MSXML Parser V4.0 
RME_CommonWin32.EXE 
RME_Notes.EXE 
RME_NotesInstall.exe (optional) 

  
Microsoft Outlook client IBM DB2 Run-Time Client Version 8.1 with Fix Pack 3 

Content Manager V8 Connector V8.2 with Fix Pack 7 
Microsoft Simple Object Access Protocol (SOAP) Toolkit V3.0 
Microsoft Visual C++ V6.0 or Microsoft .NET 
Microsoft MSXML Parser Version 4.0 
RME_CommonWin32.EXE 

 
For other sections in the "Installing and Configuring Records Manager Enabler" publication, 
please replace RME_xxxxxx.zip with RME_xxxxxx.EXE. 
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3.2 New instructions for AIX and SUN eClient server installation 
 
We have included the following new installation components for the installation of RME support 
for eClient server on AIX and SUN Solaris system platforms: 
 

RME_CommonJavaAIX 
 RME_eClientAIX 
 
 RME_CommonJavaSUN 
 RME_eClientSUN 
 
Follow these steps to install the RME support for eClient server on either AIX or SUN Solaris: 
 
For AIX: 

• Copy the RME_CommonJavaAIX file to the RME installed directory (For example: 
/usr/lpp/icm/RME) 
 

• Execute RME_CommonJavaAIX 
 

• Copy the RME_eClientAIX file to the eclient82.war directory where the eClient server is 
installed. For example, copy RME_eClientAIX to:  
 
       /opt/IBM/CMeClient/installedApp/IBM_eClient_82.ear/eclient82.war 
 

• Execute RME_eClientAIX 
 
For SUN: 

• Copy the RME_CommonJavaSUN file to the RME installed directory (For example: 
/opt/IBMicm/RME) 
 

• Execute RME_CommonJavaSUN 
 

• Copy the RME_eClientSUN file to the eclient82.war directory where the eClient server is 
installed. For example, copy RME_eClientSUN to:  
        /opt/IBM/CMeClient/installedApp/IBM_eClient_82.ear/eclient82.war 
 

• Execute RME_eClientSUN 
 
After you have copied and executed the above files, continue with the eClient server installation 
instructions in the Installing and Configuring Records Manager Enabler publication. 
 
Follow the instructions in the following sections: 
 

• Configuration eClient server to include RME support (page 24) 
• Adding RME servlets to the eClient server (page 24) 
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3.3 Using RMECMSetup tool to set up the CM server 
 
If your CM server is on either the AIX or SUN Solaris system platform, you need to run the 
RMECMSetup tool and the RMECMSamplesSetup tool on the Record Manager server machine 
to set up the CM server. These tools can ONLY be executed on Windows system platforms. 
 
See the following sections in the Installing and Configuring the Records Manager Enabler 
publication for details on how to execute these tools: 
 
        - Using RMECMSetup tool to set up the CM server (page 43) 
        - Creating RME-enabled item types (page 43) 
 
4 PTF requirements for Content Manager z/OS (CM/390) 

V8.2 
 
Although it is not described in the RME installation guide, RME supports Content Manager 
server V8.2 on OS/390 system platform. 
 
Refer to the Planning and Installing Content Manager for z/OS document for installation 
requirements for CM/390. 
 
The planning guide is available at web site: 
 
    http://www-3.ibm.com/software/data/cm/cmgr/390/library.html 
 
To support RME V8.2 on the CM/390 server, the following DB2 PTF must be installed on the 
CM server machine: 
 
      - PTF UQ72083 for DB2 V7 
 
5 Using the RMEMonitor to process the RME ACL queue 
 
Whenever the RMECMRemoteHost WebSphere Web application or the IRM server is restarted, 
you must use the RMEMonitor to restart the processing of the RME ACL queue for each of the 
CM Host Applications that is defined on the IRM system. The RMEMonitor is used to 
synchronize user permissions between IRM and CM. 
 
To start the RME ACL queue, point your Web browser to URL: 
 
 http://[servername]:9080/RMEMonitor 
 
where [servername] is the name of your IRM server. 
 
The RMEMonitor log-in Web page is displayed. Enter the CM database name, user name 
(rmeadmin, for example), and the password, and click Submit to log in. 
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The next page displays your log-in information and provides a drop-down list with the following 
options: 
 
Log out Logs you out of the RMEMonitor utility. 

 
List all items in the 
queue 

Displays a list of the ACL change requests that are submitted to this 
CM system. ACL change requests are placed in the queue whenever 
user permissions are added or changed on this CM system. 

Remove the first item 
from the queue 

Select this option to remove the first item in the queue to continue 
processing the next item in the queue. 
 

Process all items in the 
queue 

Select this option to process all items in the queue to ensure all ACL 
change requests have been processed. The queue will be empty after 
selecting this option. 

 
Select "List all items in the queue" from the drop-down list. This generates a list of the ACL 
change requests that are submitted to this CM system. Click Submit. 
 
The next page displays the items that are currently in the RME ACL queue. The number of items 
in the queue is also displayed, along with your log-in information. 
 
Select "Process all items in the queue" from the drop-down list and click Submit. This starts the 
processing of the RME ACL queue. 
 
Repeat the same steps for other CM Host Applications (if applicable) that are defined on the 
IRM system to restart their RME ACL queues. 
 
6 RME file plan filtering for classification 
 
The DOD 5015.2 standard requires that Records Management Applications be able to show only 
the portion of the file plan in which the user has enough privileges to classify the new record 
during record declaration. That is, when you click the Browse button next to the Classification 
input field on the RME - Record Profile screen to show a list of file plan classifications that you 
are authorized to classify, only those classifications to which you do not have authorization are 
not displayed. 
 
All RME client applications support the file plan filtering as a configurable option. When this 
“filtering” option is turned on, the classification selection screen will only show the portion of 
the file plan in which the user can classify the new record. When the "filtering" option is turned 
off, the classification selection screen will show the portion of the file plan that the user can 
view. To control the option, follow these instructions: 
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For RME-enabled CM eClient: 
To turn on the filtering option, set the key "IS_FILTERED" to "true" in the RME environment 
properties file (rmeenv.properties) under the RME install lib directory, for example, C:\program 
files\IBM\CM82\RME\lib\rmeenv.properties, on the eClient server. 
 
To turn off the filtering option, set the key "IS_FILTERED" to "false" in the RME environment 
properties file (rmeenv.properties) under the RME install lib directory, on the eClient server. 
 
For RME-enabled CM Windows Client, Lotus Notes Client, and Microsoft Outlook Client: 
To turn on the filtering option, define a system environment variable "RMEFILTER" and set its 
value to "1" on the client machine. To turn off the filtering option, delete the system environment 
variable "RMEFILTER", if any, on the client machine. 
 
7 IBM DB2 Content Manager V8.2 Client for Windows 

support 
 
IBM DB2 Content Manager V8.2 Client for Windows is available in two editions: Standard and 
Multi-Server. RME only supports the Standard edition. 
 
The Installing and Configuring the Records Manager Enabler publication references the 
RME_Client821.zip file, which is used to install the Content Manager V8.2 Client for Windows 
Multi-Server support. References to this file should be ignored. The file no longer exists. 
 
8 Versioning 
 
Currently IBM only supports RME-enabling Content Manager item types that have a versioning 
policy of "Never create" for both the item and any of its associated parts. In other words, any 
item type that has been enabled for records should not have any type of versioning enabled. This 
limitation will be addressed in a future version of the RME. 
 
9 Declaring folders  
 
In the current version of RME, declaring a folder as a record is not supported. This limitation 
will be addressed in a future version of the RME. 
 
10 Changes to Lotus Notes templates 
 
The Lotus® Notes™ templates were modified in Fix Pack 6 to change the way the Declare 
function is called. The template filenames are as follows: 
 

• RMEDeclareTemplate.ntf 
• RMEDiscuss.ntf 
• RMEMail50.ntf 

 

 Version 1.0  
20 



IBM Records Manager Enabler for Content Manager Version 8.2 Fix Pack 7 readme 

 
If you created your own templates from one or more of these templates, you should make the 
following updates to your templates using Lotus® Domino™ Designer: 
 
Under Agents → (RMEDeclare) → (Declarations) change reference of leRSnotesComp08.dll 
to leRSnotesCompA8.dll. The updated line should appear as follows: 
 
 Declare Function IeRSDeclareNoteDocumentButton Lib "IeRSnotesCompA8.dll" 
 
11 Known problems 
 
11.1  Records Manager "Reset Descendants" function problem 
 
For the current RME release, the Security → System Permissions → Reset Descendants 
function on the Records Manager client is NOT supported. 
 
If you select Reset Descendants on the Security → System Permissions screen, you will get an 
error message from the RME system. 
 
The work-around is to use the Reset Descendants function at the File Plan Administration → 
Actions → Permissions function screen. 
 
11.2  Configuration key added for host delete error 
 
The configuration key CM_DELETE_FAIL_NOTIFY=0|1 has been made available for a work-
around to a known host-delete exception that occurs if there are inconsistencies between IRM 
and CM. The exception occurs when an administrator deletes an item that has been declared a 
record from CM (the user would require to have a super user ID to do this.) This situation can 
also arise if an administrator performs a database restore of either IRM or CM. Performing an 
operation on a record that has been affected (for example, deleted) via the IRM Records 
Administration Console will cause the exception to surface. The new configuration key allows 
administrators a way to delete all affected records. 
 
The configuration key must be specified in the file rmeenv.properties located in the RME 
installation directory (for example, c:\Program Files\IBM\CM82\RME\lib). If the configuration 
key is set to “0” (CM_DELETE_FAIL_NOTIFY=0) and the delete error condition is 
encountered, the host exception will not surface. This is the default. Otherwise, set this key to 
“1” (CM_DELETE_FAIL_NOTIFY=1) to indicate that if the exception is thrown the current 
operation is deleted. 
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12  Notices 
 
This information was developed for products and services offered in the U.S.A. 
 
IBM may not offer the products, services, or features discussed in this document in other 
countries. Consult your local IBM representative for information on the products and services 
currently available in your area. Any reference to an IBM product, program, or service is not 
intended to state or imply that only that IBM product, program, or service may be used. Any 
functionally equivalent product, program, or service that does not infringe any IBM intellectual 
property right may be used instead. However, it is the user's responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service.  
 
IBM may have patents or pending patent applications covering subject matter described in this 
document. The furnishing of this document does not grant you any license to these patents. You 
can send license inquiries, in writing, to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual 
Property Department in your country or send inquiries, in writing, to: 
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 
 
The following paragraph does not apply to the United Kingdom or any other country 
where such provisions are inconsistent with local law:  
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS 
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain transactions, 
therefore, this statement may not apply to you.  
 
This information could include technical inaccuracies or typographical errors. Changes are 
periodically made to the information herein; these changes will be incorporated in new editions 
of the publication. IBM may make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 
 
Any references in this information to non-IBM Web sites are provided for convenience only and 
do not in any manner serve as an endorsement of those Web sites. The materials at those Web 
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sites are not part of the materials for this IBM product and use of those Web sites is at your own 
risk. 
 
IBM may use or distribute any of the information you supply in any way it believes appropriate 
without incurring any obligation to you. 
 
Licensees of this program who wish to have information about it for the purpose of enabling: (i) 
the exchange of information between independently created programs and other programs 
(including this one) and (ii) the mutual use of the information which has been exchanged, should 
contact: 
 
IBM Corporation 
J46A/G4 
555 Bailey Avenue 
San Jose, CA  95141-1003 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, including in 
some cases, payment of a fee. 
 
The licensed program described in this document and all licensed material available for it are 
provided by IBM under terms of the IBM Customer Agreement, IBM International Program 
License Agreement or any equivalent agreement between us. 
 
Any performance data contained herein was determined in a controlled environment. Therefore, 
the results obtained in other operating environments may vary significantly. Some measurements 
may have been made on development-level systems and there is no guarantee that these 
measurements will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results may vary. Users of 
this document should verify the applicable data for their specific environment. 
 
Information concerning non-IBM products was obtained from the suppliers of those products, 
their published announcements or other publicly available sources. IBM has not tested those 
products and cannot confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM products should be 
addressed to the suppliers of those products. 
 
All statements regarding IBM's future direction or intent are subject to change or withdrawal 
without notice, and represent goals and objectives only. 
 
This information contains examples of data and reports used in daily business operations. To 
illustrate them as completely as possible, the examples include the names of individuals, 
companies, brands, and products. All of these names are fictitious and any similarity to the 
names and addresses used by an actual business enterprise is entirely coincidental. 
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COPYRIGHT LICENSE: 
 
This information contains sample application programs in source language, which illustrate 
programming techniques on various operating platforms. You may copy, modify, and distribute 
these sample programs in any form without payment to IBM, for the purposes of developing, 
using, marketing or distributing application programs conforming to the application 
programming interface for the operating platform for which the sample programs are 
written. These examples have not been thoroughly tested under all conditions. IBM, therefore, 
cannot guarantee or imply reliability, serviceability, or function of these programs. You may 
copy, modify, and distribute these sample programs in any form without payment to IBM for the 
purposes of developing, using, marketing, or distributing application programs conforming to 
IBM's application programming interfaces. 
 
Portions of this product were developed by The Apache Software Foundation 
(http://www.apache.org/) Copyright © 1999 The Apache Software Foundation. All rights 
reserved. 
 
THE LOG4J, XERCES, XALAN SOFTWARE ARE  PROVIDED ``AS IS'' AND ANY 
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL IBM OR THE APACHE 
SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
 
The following terms apply to the LOG4J, XERCES, XALAN components: 
 
Redistributions in binary form must reproduce the above copyright notice, this list of conditions 
and the above disclaimer in the documentation and/or other materials provided with the 
distribution. 
 
The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software 
Foundation  (http://www.apache.org/)." Alternately, this acknowledgment may appear in the 
software itself, if and wherever such third-party acknowledgments normally appear. 
 
The names "log4j, xerces, xalan" and  "Apache Software Foundation" must not be used to 
endorse or promote products derived from this software without prior written permission. For 
written permission, please contact apache@apache.org. 
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Products derived from this software may not be called "Apache", nor may "Apache" appear in 
their name, without prior written permission of the Apache Software Foundation. 
 
Trademarks 
 
The following terms are trademarks of the International Business Machines Corporation in the 
United States, other countries, or both: 
 
IBM    DB2   WebSphere   z/OS 
 
Domino, Lotus, Lotus Notes are trademarks or registered trademarks of the Lotus Development 
Corporation in the United States, other countries, or both. 
 
Microsoft, Windows, and Windows NT are registered trademarks of Microsoft Corporation in 
the United States, other countries, or both. 
 
Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United 
States, other countries, or both 
 
Other company, product, and service names may be trademarks or service marks of others. 
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